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Kendrion Kuhnke Automation GmbH

Legal Notice

1 Legal Notice
1.1 Contact Details

Kendrion Kuhnke Automation GmbH
Industrial Control Systems
Latjenburger Strafl3e 101

D-23714 Malente, Germany

Tel. +49 4523 402-0

Fax +49 4523 402-201
Emailsales-ics@kendrion.com

Web www.kuhnke.kendrion.com

1.2 Version Details

1.2.1 Manual

Modification history

Version Date Comments / modifications
1.00 03. Mar 2017 First Version
1.01 07. Mar 2017 Modification after review
1.02 05. Apr 2017 Modification after review
1.03 07.May 2017  Maodification after review
1.04 31. May 2017  Modification after review
Warning "Operation exclusively with ETG-compliant modules”, update
1.05 19. June 2017 safety-related characteristic values
Safety-relevant characteristic values after modification test
L0 24. Aug 2017 1(3y Rheinland updated
Objects 210An "SW Build No" and 2212 "Post Result Flag" added.
1.07 26. Jan 2018 User instructions for the safety task time setting added.
Declaration of Conformity and TUV Certificates inserted
108 19 Mar 2018 Note added to the ERRATA_Sheet_Safety

Additionally: unique date format selected

1.09 26. Mar 2019

Changes in chapter 7.3.20 Read MC 3 Error 2210n for details see
ERRATA_Sheet_Safety.

1.2.2 Manual version / Safety PLC version

The following table describes the relationship between the module release (module version) and the corre-

sponding manual version.

Module release

Version Manual Date
V1.04 V1.09 26. Mar 2019

Kuhnke FIO Safety PLC (E 842 GB)
26. Mar 2019

Comments / modifications
Applies to module release up to V1.04


mailto:sales-ics@kendrion.com
http://www.kuhnke.kendrion.com/
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1.2.3 Terminology

Terminology

Term

Safety PLC
Standard PLC
CODESYS
Safety package
PLCopen Safety
FIO system

FIO PLC

Head module

CODESYS safety extension
Logical exchange variables

Kuhnke FIO Safety PLC (E 842 GB)
26. Mar 2019

Explanation

The safety control unit described in this document

Main control of the system that provides the EtherCAT master
Programming environment of the standard PLC

CODESYS safety extension

Certified library of safety function blocks

Series of FIO modules

Compact controller designed for the FIO system

Generic designation of a bus coupler or compact controller as part of
the FIO system

Certified safety programming environment

Let you exchange information between the safety PLC and the stand-
ard PLC (see CODESYS Safety Manual)
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2 Preface
2.1 About this User Guide

This document is the manual for users of the Safety PLC module assigned product number 694 330 00.

For your work with the module, always consult the CODESYS Safety User Guide version certified for
CODESYS Safety 1.2.0 as provided by 3S-Smart Software Solutions GmbH.

This document is intended for the target group described in section 2.2.2 Target Groups of the User Guide. It
does not contain any availability information. We reserve the rights for errors, omissions and modifications.
Pictures are similar.

ﬂ Note, information

Please also note the ERRATA_Sheet_Safety for currently relevant safety warnings.
The current version can be found in our product finder Link.

2.1.1 Limitation of Liability

All specifications are only of a descriptive nature and must not be understood as guaranteed product proper-
ties in a legal sense. Exact properties and characteristics shall be agreed in the specific contract. Claims for
damages against us - on whatever grounds - are excluded, except in instances of deliberate intent or gross
negligence on our part.

2.1.2 Terms of Delivery

The general conditions of sales and service of Kendrion Kuhnke Automation GmbH shall apply.

2.1.3 Copyright

Copyright © Kendrion Kuhnke Automation GmbH
This user guide is protected by copyright.

No part of this document may be reproduced or copied in any way or by any means except expressly permit-
ted in writing by Kendrion Kuhnke Automation GmbH.

Microsoft®, Windows® and the Windows® logo are registered trademarks of Microsoft Corp. in the USA and
other countries.

EtherCAT® is a registered brand and patented technology, licenced by Beckhoff Automation GmbH, Ger-
many.

Safety over EtherCAT is a registered trademark and patented technology, licenced by Beckhoff Automation
GmbH, Germany

Further information about the PLCopen organisation is available at www.plcopen.org. CIA® and CANopen®
are registered joint brands of CAN in Automation e.V. Title to all companies and company names mentioned
herein as well as to products and product names is held by the respective enterprises.

Kuhnke FIO Safety PLC (E 842 GB) 9
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2.1.4 Warranty

Warranty is subject to the provisions of the conditions of sale of BYKK Kendrion Kuhnke Automation GmbH
or any contractual agreements between the parties.

The warranty will be voided by:

improper assembly and use,

repairs or inadmissible servicing,

opening the module housing,

modifying or removing the serial number or rendering it illegible.

N2 2R\

2.1.5 Symbols and Means of Presentation

You will find the following symbols and means of presentation throughout this user guide:

Symbols and Means of Presentation

Symbol Explanation
> .. List item
> Single instruction or list of instructions for actions that can be taken in any order.
1. List of instructions for actions to be taken in the specified order.
2.
ﬂ Further product information
Kuhnke FIO Safety PLC (E 842 GB) 10
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2.2 Reliability, Safety
2.2.1 Applicability

This user guide contains all the information you need to use the product described as intended.

2.2.2 Target Groups of the User Guide

The user guide is written for design, project planning, servicing and commissioning experts. For proper un-
derstanding and error-free application of technical descriptions, instructions for use and particularly of notes
of danger and warning, extensive knowledge of automation technology and functional safety is compulsory.

2.2.3 Hazard and Other Warnings

Despite the actions described in section 2.2.5Safety , the occurrence of faults or errors in electronic control
units - even if most highly improbable - must be taken into consideration.

Please pay particular attention to the additional notices which we have marked by symbols throughout this
user guide. While some of these notices make you aware of possible dangers, others are intended as a
means of orientation. They are described further down below in descending order of importance.

Every alert and hazard warning is made up as follows:

Optional: Type and source of risk
Further Brief description of risk and potential consequences of non-observance
symbols »  Preventive measures

The signal words below are used for warnings you must respect for your own safety and to avoid material
damage.

DANGER

A DANGER warning makes you aware of an immediately hazardous situation which WILL cause a serious
or fatal accident if not observed.

A WARNING makes you aware of a potentially hazardous situation which MAY cause a serious or fatal
accident or damage to this or other devices if not observed.

CAUTION

A CAUTION alert makes you aware of a potentially hazardous situation which MAY cause an accident or
damage to this or other devices if not observed.

2.2.4 Other Notices

ﬂ Note, information
This symbol draws your attention to additional information concerning the use of the described
product. This may include cross references to information found elsewhere (e.g. in other manuals).

Kuhnke FIO Safety PLC (E 842 GB) 11
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2.2.5 Safety

Our products normally become part of larger systems or installations. The information below is intended to
help you integrate the product into its environment without dangers to humans or material/equipment.

DANGER

Non-compliance with the user guide

Measures for the prevention of dangerous faults or errors may be rendered ineffective or new hazard
sources created.

»  Carefully read the user guide.

»  Take particular heed of the hazard warnings.

ﬂ To achieve a high degree of conceptual safety in planning and installing an electronic controller, it
is essential to exactly follow the instructions given in the user guide because wrong handling could
lead to rendering measures against dangers ineffective or to creating additional dangers.

Kuhnke FIO Safety PLC (E 842 GB) 12
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2.2.6 Project Planning and Installation

>
>

9
9

Comply with the safety and precautions regulations for qualified applications.

Please pay particular attention to the notices of warning which, at relevant places, will make you aware of
possible sources of dangerous mistakes or faults.

Always comply with the relevant standards and VDE regulations.
Control elements are to be installed in such a way as to exclude unintended operation.

2.2.7 Maintenance and Servicing

>
>
>

9

Accident prevention regulations (in Germany: BGV A3 - VBG 4.0) to be observed when measuring or
checking a controller after power-up. This applies to section 8 (Admissible deviations when working on
parts) in particular.

The Safety PLC module is maintenance-free, there are no spare parts

You are not allowed to repair the Safety PLC module. Please return the defective module and a problem
description to BYKK Kendrion Kuhnke Automation GmbH.

De-energise the module before making changes to the structure or wiring. You may otherwise destroy the
module or jeopardise its functionality. In addition, unexpected danger situations can arise, which can lead
to accidents.

2.2.8 General Notes on Installation

As component parts of machines, facilities and systems, electronic control systems must comply with valid
rules and regulations, depending on their field of application.

General requirements concerning the electrical equipment of machines and aiming at the safety of these ma-
chines are contained in Part 1 of European Standard EN 60204 (corresponds to VDE 0113).

In order to safely install the Safety PLC, take heed of the information in section 6 Installation and
Operation and later.

Interference emission
Interfering emission of electromagnetic fields, HF compliant to EN 55011, limiting value class A, Group 1

If the controller is designed for use in residential areas, high-frequency emissions must comply
with limiting value class B as described in EN 55011.

Fitting the controller into earthed metal cabinets and installing filters in the supply lines may pro-
duce a shielding compliant to the above standard.

The design and immunity to interference of programmable logic controllers are internationally governed by
standard IEC 61131-2:2007 which, in Europe, has been the basis for European Standard EN 61131-2:2007 .

Refer to IEC 61131-4, User's Guideline, for general installation instructions to be complied with to
ensure that hardware interface factors and the ensuing noise voltages are limited to tolerable lev-
els.

Kuhnke FIO Safety PLC (E 842 GB) 13
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Electrical immission safeguard
> To eliminate electromagnetic interference, connect the control system to the protective earth conductor.

Cable routing and wiring
> Keep power circuits separate from control circuits:
DC voltage, 60...400 V
AC voltage, 25...400 V
> Jointly lay the following control circuits only:
shielded data signals
shielded analogue signals
shielded digital I/O lines
unshielded DC voltages < 60 V
unshielded AC voltages < 25V

Location of installation

> Ensure that temperatures, contaminations, impact, vibration or electromagnetic interference are no impedi-
ment to the installation.

Temperature
> Consider heat sources: general heating of rooms, sunlight, heat accumulation in assembly rooms or control
cabinets.

Contamination

> Use suitable casings to avoid possible negative influences due to humidity, corrosive gas, liquids or conduct-
ing dust. (Eg installation in a suitable control cabinet).

Impact and vibration

> Consider potential influences caused by motors, compressors, transfer lines, presses, ramming machines
and vehicles.

Electromagnetic interference

> Consider electromagnetic interference from various local sources: motors, switching devices, switching thy-
ristors, radio-controlled devices, welding equipment, arcing, switched-mode power supplies, converters / in-
verters.

Kuhnke FIO Safety PLC (E 842 GB) 14
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3 System Description

The Safety PLC integrates functional safety in the control system, making the separate wiring of safety cir-
cuits a thing of the past. The job of the Safety PLC is to run the safety application programme and to share
the safety-related control information with the assigned safe slave modules.

Fig. 1: Safety PLC

Using the Safety PLC requires the use of a higher-level control unit based on CODESYS and referred to as
the standard PLC below as well as EtherCAT as the fieldbus for data exchange.

Kuhnke FIO Safety PLC (E 842 GB) 15
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3.1 Control System — Overview of Functionality

The picture below illustrates an example of a control system featuring a Safety PLC.

Programming System
(CODESYS) Standard-PLC Standard 1/0 Safety Inputs

EtherCAT- EtherCAT- =
Slave Slave =
FSoE Slave =
EtherCAT- =
|:|7 Master =
______ ! | PRSP
1 Safety PLC
1 (safety control unit) Safety Inputs Safety Outputs Standard I/O
1 = = =
] EtherCAT- = = EtherCAT- = EtherCAT-
1 Slave = = Slave = Slave
I FSoE Master = = FSoE Slave =
1 = = =
1

Fig. 2: System overview

Ethernet links the programming PC running the programming system with the standard PLC in order to pro-
gram it. Making use of the EtherCAT fieldbus, the standard PLC may then program one or several Safety
PLC.

In normal service mode, EtherCAT exchanges the process data between the standard PLC and the standard
actuators and sensors.

At the same time, the Safety PLC uses the EtherCAT fieldbus and the protocol “FSoE” to exchange the
safety-related signals with safe I/O modules or drives.

3.2 EtherCAT® — Ethernet Control

EtherCAT in an Ethernet-based fieldbus system whose speed makes it a good choice of a fast drive and I/O
bus of control units (industrial PC or PLC).

Its interconnections between the controller at one end and both the 1/0O modules and drives at the other are
as fast as those of a backplane bus. EtherCAT controllers thus nearly act like centralised control systems,

Kuhnke FIO Safety PLC (E 842 GB) 16
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3.3 FIO system

The Safety PLC is a module of the FIO system which is a collection of stackable modules that integrate in an
EtherCAT network for transferring the process signals.

Acting as the head module, the FIO bus coupler converts the twisted pair-based transfer to LVDS (E-bus)
and generates the system voltages for the LVDS modules. The standard 100 Base Tx lines connect to the
one side, the FIO modules for the process signals stack up at the other. This is how the EtherCAT protocol is
retained right through to the last I/O module.

Instead of a bus coupler, the head module may also be an FIO PLC which will then also act as the standard
PLC and the bus master.

EtherCAT — l i 'E 'Inél i

0
Fig. 3: FIO system

Designation

PLC with FIO expansion modules 4 Expansion modules
2 Bus coupler with FIO expansion modules 5 Bus coupler
3 FIO PLC
Kuhnke FIO Safety PLC (E 842 GB) 17
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3.4 FIO Safety System

The FIO safety system adds the Safety PLC of this guide and modules with safe inputs and outputs to the
FIO module system, making the separate wiring of safety circuits a thing of the past. The EtherCAT protocol
is used to transfer both safe and standard signals to the Safety PLC. This integration is based on the certi-
fied FSoE safety protocol.

3.4.1 Safety over EtherCAT (FSoE)

Along with EtherCAT, a safety protocol was developed and made available for EtherCAT as "Safety over
EtherCAT" (FSoE = Fail Safe over EtherCAT). It is the backbone of providing functional safety over Ether-
CAT. Both the protocol and its implementation are certified to comply with Safety Integrity Level 3 (SIL 3) to
IEC 61508. In 2010, IEC 61784-3-12 was published as the international reference standard for Safety over
EtherCAT.

Since EtherCAT is used as a single-channel medium of communication, Safety over EtherCAT does not im-
pose any constraints regarding the transfer rate and cycle time. The transport medium is considered a "black
channel" which is left out of the safety assessment.

Safety over

EtherCAT.

Fig. 4: FSoE logo

3.4.2 Safety PLC

The Safety PLC links the FIO safety system's inputs and outputs to the safety-related signals of other FSoE
equipment of the installation.

It generally interacts with a higher-level CODESYS PLC referred to as the standard PLC in this guide. The
Safety PLC has a two-channel architecture which supports communication with both the programming sys-
tem via the standard PLC and with the standard PLC's non-safe variables and its inputs and outputs using
logical exchange variables (see CODESYS Safety Manual - "Logical 1/0s").

3.4.3 CODESYS Safety

A certified and fully integrated plug-in (safety package) of the CODESYS development system is used to pro-
gram the safety PLC.

In the tree of units, the Safety PLC is shown under the standard PLC as an EtherCAT slave node with its
own applicatin, a task, lists of global variables, POUs and logical I/Os. It provides all functions described in
the CODESYS® Safety Manual for CODESYS version 1.2.0, the only restriction being that the only way of
integrating it is using EtherCAT as the medium of communicating with the Safety PLC.

The integrated function diagram (FD) safety editor (to IEC 61131-3, certified for use with IEC 61508 SIL3 ap-
plications) is used for basic or extended-level programming by means of certified function blocks (IEC 61131-
3 or PLCopen Safety) as specified in the CODESYS user manual.

At the basic level, certified function blocks (PLCopen safety) are graphically "wired up" to establish the sys-
tem's safety programme. In case a project demands more than the technology of the certified blocks can pro-
vide, the extra instructions available at the extended level can be used to expand the safety programme.

Further software functions are available for safeguarding the safety functions by change tracking, safe flow
of signals, safe version control (pinning), separating safe operation, and debugging mode.

CODESYS

Fig. 5: CODESYS logo
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3.4.4 PLCopen Safety Library in the CODESYS Environment

The PLCopen components have been defined and certified by the PLCopen organisation, its members and
external organisations specialising in all safety-related aspects. The components interlink by logical opera-
tions which behave like logical wiring and admit the reliable programming of a safety application.

PLCopen®

A m

Fig. 6: PLCopen logo

The use of certified secure blocks alone does not guarantee that the user program is fault-free.
Each program must be developed and thoroughly tested for safety.

Kuhnke FIO Safety PLC (E 842 GB) 19
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4 Product Description
4.1 Safety PLC

The job of the Safety PLC is to integrate safety functions in a control system. The Safety PLC essentially
consists of two microprocessors which implement the safety functions, exchange process data and mutually
monitor one another. A third microprocessor manages all external communication processes.

To support its integration in an FIO system, the Safety PLC is designed as a stackable module which may be
installed on a DIN rail in a switching cabinet.

General view:

8 —
— W
|
.‘ e | 2
¢ |
1
= 5

Fig. 7: External features of the Safety PLC module

Grip Shield-to-housing mount connector
2 Labelling clip 6 DIN rail mount and functional earth
3 Unlock button 7 Module lock, E-bus
4 Status LEDs 8 Ventilation slots

The housing mount consists of an aluminium profile with an integrated clamping fixture used to attach the
module to a 35 mm DIN rail. The housing trough including the optical fibres for the status indicators, the side
faces and the front are made of plastic and contain the module.

4.2 Application
4.2.1 Intended Use

The FIO system is a system of I/O modules for interconnecting the process signals in an EtherCAT network.
It consists of the bus coupler and a range of I/O modules. The FIO safety system comprising the Safety PLC
and the FIO safety module provides functions which allow the use of the FIO system for applications de-
manding the functional safety of machinery.

It is intended for applications requiring safety functions of machines or systems and all industrial automation
tasks immediately associated with them. Thus, the system may only be used for applications providing a de-
fined fail-safe state. By definition, a wattless state is "fail-safe". Running any of the safety-related control
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components is subject to the safety precautions applicable to industrial control units, i.e. guarding by emer-
gency stop and similar safety equipment as specified by the relevant national and/or international regula-
tions. The same applies to connected equipment such as drives or light grids.

Before installing and putting the system into operation, the safety instructions, connection specifications
(nameplate and documentation) and the limiting values listed in this user guide's Technical Data section
must be read carefully and obeyed at any time. The system is not designed for applications causing poten-
tially fatal risks or dangers to the life and health of many persons or disastrous ecological hazards unless ex-
ceptionally strict safety precautions are taken. Forbidden applications specifically include the monitoring of
nuclear reactions in nuclear power stations as well as the control of flight or air traffic control systems, means
of mass transit, medical life support systems and weapon systems.

In particular, only use within the framework of the applicable Machinery Directive (Directive 2006/42 / EC) is
authorized.

Impairment of safety when using unsuitable EtherCAT modules!
» The Safety-PLC may only be operated with ETG-compliant modules on one bus.

Impairment of security when using unsuitable FSoE Slavemodule!
» The Safety PLC may only be used with FSoE compliant and certified slave modules.

Kuhnke FIO Safety PLC (E 842 GB) 21
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4.2.2 Qualified Persons

The safety-related products may be used by the following persons only:

- Qualified persons who know the applicable concepts of functional safety as well as the relevant standards

and regulations.

- Qualified persons who plan, design, install and put machine and system safety equipment into operation.
This manual's safety instructions construe qualified persons as persons whose training, experience, instruc-
tions and knowledge of the applicable standards, codes, accident prevention regulations and operating con-
ditions authorise them to perform the required work and enable them to recognise and avoid potential haz-
ards associated with that work. Language skills sufficient to understand this manual are therefore part of this
qualification.

WARNING

Improper operation by unqualified persons!
» Have only properly qualified persons install and program the Safety PLC.

4.2.3 Disclaimer of Liability

The operator is responsible for self-reliantly running the safety-related control components in conformity with
the requirements set by the competent authority.

The manufacturer shall neither be held liable nor accept any warranty for damages caused by:
inappropriate use,

non-compliance with standards and directives,

unauthorised modifications of devices, connections or settings,

the use of unapproved or unsuitable equipment or equipment groups,

non-observance of the safety instructions contained in this manual.

N2 20 2 2%
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4.3 Safe State

There are two different types of "safe states":

- The first one is functional and depends on the machine's application, operation and software. It is the
aimed-for safe functional state at which the system works without problems.

-  The second one is the fail-safe state assumed in response to any internal fault or error. The second one is
the fail-safe state and is assumed in the case of an internal or externally detected fault.

4.3.1 Safe Functional State

The state is functionally safe when everything is working as it should.

It includes errors indicated to the Safety PLC by any of the modules connected to it. These errorr generally
do not change the safe functional state and are therefore handled by the safety application (e.g. loss of com-
munication with a safe 1/O module).

4.3.2 Fail-Safe State

Internal error

The state of the Safety PLC is considered "fail-safe" when valid FSoE frames are no longer sent to the asso-
ciated safe FSoE slaves. In the absence of valid FSoE telegrams, the outputs of the FSoE slaves will
change to save state (Outputs currentless).

If affecting safety, internal errors are responded to by changing to the fail-safe state which also stops FSoE
communication. To the extent possible, EtherCAT communication will still be enabled and provide diagnostic
options.

External Error

The module monitors its supply voltage (high and low voltage) and the admissible operating temperature.
Whenever either of the two is outside the admissible range, the Safety PLC changes to the fail-safe state
and stops sending FSoE frames.

To quit the fail-safe state

The only way of quitting the fail-safe state is to turn off the power supply to the head module (bus coupler or
PLC). Initialising after powering up again includes a complete self-test.

In conformity with the FSoE specification, FSoE slaves linked into the system will change to the safe state if
a correct FSoE frame fails to be received before the watchdog times out.
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4.3.3 Traceability

Traceability means that the time, place and entity that produced, processed, stored, transported, consumed
or disposed of a product or trading good can be traced back at any time.

Whereas BYKK Kendrion Kuhnke Automation GmbH is able to meet this requirement with regard to produc-
tion, processing, storage and transport, the purchaser is responsible for all further whereabouts of the prod-
uct.

Identification and, thus, traceability of the product is ensured by its serial number which is printed on the front
of the module and on a decal on the underside of the module. Or you can retrieve it by software means. To
ensure proper traceability, the purchaser is obliged to note down this number together with the machine's
name, place of installation and end customer.

ﬂ The purchaser must ensure the units' traceability by means of their serial number.

4.4 Useful Life

The Safety PLC modules have a design life of max. 20 years after the date of manufacture (see section 5.1
Labelling and Identification). The module to be removed from service not later than one week before the end
of this 20-year period (see section 6.10.3 Taking out of Service).

The date of manufacture is part of the serial number printed on the housing and stored in the Safety
PLC's memory (see section 5.1.2 Serial Number).
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4.5 Technical Data

4.5.1 General specifications

Device data
Product name
Fieldbus
E-bus port

Memory for CODESYS application and
configuration data

Electrical insulation

Diagnosis

E-bus load
Terminating module
System power supply

Supply voltage

Overvoltage category
Reverse polarity safeguard
Susceptibility to noise

Storage and transport conditions
Ambient temperature

Rel. humidity

Atmospheric pressure

Vibration

Shock

Service conditions

Mounting position

Degree of contamination
Admissible operating environment

Operating temperature
Relative humidity
Atmospheric pressure
Altitude of site
Vibration

Kuhnke FIO Safety PLC (E 842 GB)
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Value

Safety PLC
EtherCAT 100 Mbps
10-pin system plug in side wall

A total of 512kbytes are available: :
e 400KByte for the CODESYS application
e 112kByte for the configuration data

all modules electrically insulated from one another and from
the bus

LEDs (see section 5.3 Status LEDs)
max. 240 mA (system power supply)
module bus to be covered on the last module

5 VDC via E-bus link

supplied by the head module (bus coupler or PLC which are
powered by 24 VDC, in accordance with EN 61131-2, min. -
15% / +20% SELV/PELV)

category Il to IEC 60664-1 in conformity with EN 61131-2
yes

install in zone B (61000-6-2 in conformity with EN61131-2), in-
stall on earthed DIN rail in an earthed switching cabinet. Lay
the earth cable according to service conditions (see section
6.2.1 Earthing)

—25°C...+70 °C
5% ... 95%, non-condensing
70 kPa...108 kPa

5 Hz...8.4 Hz: £3.5 mm amplitude, 8.4 Hz...150 Hz: 10 m/ s?
(19g) to IEC 60068-2-6, Fc test

150 m/s? (15g), 11 ms semi-sinusoidal wave to IEC 60068-2-27

horizontal, stackable
Il to IEC 60664-3

operation restricted to environments complying with IP54 or
better to IEC 60529 (e.g. suitable control cabinet)

0 °C...+55°C

5% ... 95%, non-condensing
80 kPa...108 kPa

max. 2000 m above MSL

5 Hz...8.4 Hz: £3.5 mm amplitude, 8.4 Hz...150 Hz: 10 m/s?

(19),
to IEC 60068-2-6, Fc test
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Shock

Mechanical properties
Installation

Dimensions (W x H x D)
Ingress protection
Housing mount

Shield

150 m/s2 (15g), 11 ms semi-sinusoidal wave to IEC 60068-2-27

35 mm DIN rail (top-hat rail)
25 mm x 120 mm x 90 mm
IP20

aluminium

connects straight to module housing

4 5.2 Size of FSoE Data Frame

According to the FSoE protocol, the maximum frame size is 1322 bytes. This is also the maximum amount of
data that a Safety PLC can exchange with the FSoE slaves.

To calculate the maximum number of FSoE slaves supported by a Safety PLC, just add up the safe I/O data
of every slave plus the protocol overhead (the result corresponds to the size of the image). Refer to the prod-
uct description of the FSoE slave in question to find the relevant size details.

Typical values for the size of the FSoE image of an FSoE slave depending on the safe | / O user data:

i Payioad data (Bytes

o A N P

16
32

The general rule:

6
7
11
19
35
67

Size of the FSoE image = 2 x secure | / O data + 3 byte data (CMD + Connection ID)

The minimum size of the image is 6 bytes

ﬂ A safety application will fail to start if its configuration exceeds the above maximum size of the

FSoE data frame.

4.5.3 Cycle time setting of the safety application

The programming system is used to set the cycle time of the safety application. Settings in the range from
4 ms to 600 ms can be varied at steps of 1 millisecond.

ﬂ Values outside the range can not be set.
When the safety application is loaded onto the Safety PLC, a fault message is displayed.

For new safety projects it is recommended to set the safety task time to a high value (for example 50ms).
When the project is running, the currently required safety task runtime can be read out in the object. (SDO
object 2220 subindex 4) This value can then be accepted with a buffer (for example + 20%).

Kuhnke FIO Safety PLC (E 842 GB)
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4.5.4 Response Time

The total response time of a safety system (consisting of the Safety PLC, safe I1/O modules linked in via
FSoE, and the sensors and actuators connected to the safe /0 modules) is made up of the signal pro-
cessing times of each of the components (see picture below). The response time of the Safety PLC of this
user guide equals the task cycle time set in the safety application.

total time to respond

T_Sensor
T Input

T_FSoE

T_SafetyPLC

signal processing by sensor
signal processing by safe I/O module

data transfer via Ethercat

runtime of Safety PLC programme
data transfer via Ethercat

signal processing by safe 1/0 module
signal processing by actuator

b _

T_Input T_Output

T_FSoE T_FSoE

T_SafetyPLC

module time to respond

system time to respond

Fig. 8: Response time in the system group (example)

Description

Sensor's processing time up until it delivers the signal to the interface.
This time is normally specified by sensor manufacturer.

Processing time of a safe input, e.g. a SDI4/SDO2 module.
This time is listed among the input module's technical data.

Communication processing time amounting to max. 3x the EtherCAT cycle time. This is
due to the fact that sending any new data must wait for the next safety-over-EtherCAT
frame and that, after sending, the higher-level standard PLC must first of all copy the data.
The communication processing time therefore directly depends on the cycle time of the
EtherCAT master.

Processing time of the Safety PLC which is the same as the cycle time set for the safety
application.

The Safety PLC will change to the safe state if this time is not achieved due to an exces-
sive level of program complexity.

T_Output Processing time of a safe output, e.g. a SDI4/SDO2 module.
This time is listed among the output module's technical data.
T_Aktor Actuator's processing time. This time is normally specified by actuator manufacturer.
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CAUTION
To calculate the safe response time, take account of the fieldbus runtimes and the Safety PLC's
cycle time.
>

The fieldbus runtimes and the Safety PLC's cycle time must be taken account of to rate and calcu-
late the safe response time.

» Inthe worst case, the fieldbus runtime must be assumed to amount to 3x the EtherCAT cycle time
per direction of data transfer.

ﬂ Since an error can occur during the Safety PLC cycle, the maximum system reaction time must

always be assumed for the reaction time. This is adjustable by the Watch Dog time of the FSoE
Slaves.
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4.5.5 Dimensions
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Fig. 9: Dimensions, in mm
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4.6 Transport and Storage

At times of transport and storage, protect the Safety PLC against inadmissible exposure such as mechanical
stress, temperature, humidity and/or aggressive atmospheres.

>
>
>

Transport and keep the Safety PLC in its original packaging.
Avoid soiling or damaging the contacts when picking the product or placing it in a different box.

Keep and transport the Safety PLC in suitable containers/packages in due compliance with ESD instruc-
tions.

Some parts of the units are sensitive to ESD and may be damaged if handled inappropriately.

>

When putting the Safety PLC module into service or when doing any maintenance, take the required precau-
tions against electrostatic discharge (ESD).

CAUTION

Electrostatic discharge!
Destruction of or damage to the unit.

» Use the original packaging for transporting or storing the Safety PLC module.
» Ensure that the ambient conditions are as specified at all times during transport and storage.
» Handle the Safety PLC modules in a well-earthed environment (persons, place of work, packaging).
» Do not touch electrically conductive parts such as data contacts. Some of the electronic compo-
nents may be destroyed if exposed to electrostatic discharge.
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5 Construction and Functionality

5.1 Labelling and ldentification
5.1.1 Imprinted Texts and Symbols

Safety over —1
EtherCAT. I:
C E Safety PLC
c@“’ ':I‘EStI'lfergAT Run
LISTED BSafe Status
56DM @afLC
7 -
D <>, 2
i O
Kuhnke FIO 694 330 00
Safety PLC V1.0
Protocol FSoE
Runtme  CODESYS Safety 35
: ®
Temp.55C max. @ 25
%
X
W Z
7]
43 {3 & &
/_E Kendrion Kuhnke Automation GmbH @
Latienburger Str.101, D-23714 Malente
www_kendrion.com Made in Germany
e B O e |
| o [ e |

Fig. 10: Imprinted texts and symbols

mark of approval serial number on underside
2 manufacturer's label 5 operative earth
3 operating conditions 6 serial number on front side
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5.1.2 Serial Number

The serial number is vertically printed on the front panel. You will also find it on the decal on the back of the
module.

The numerical code incorporates the production date and a serial number. It allows BYKK Kendrion Kuhnke
Automation GmbH to identify the unit's history, model, software and hardware revision.

—— a—

Safety PLC

@EtherCAT Run
@ Safe Status
@PLC

SN XXX

Fig. 11: Front view showing the serial number (SN)

Make-up of serial number: YY MM DD NNNNN

Y = year (production date)
M = month (production date)
D = day (production date)

N = consecutive number

The serial number is also stored in sub-index 4 of object 1018» and can be accessed by an Ether-
CAT SDO (see section7.2.7 Identity Object 1018h).

5.2 Contents of Package

->  Safety PLC
> Module bus cover
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5.3 Status LEDs

Safety PLC

GEtherCAT Run
@ Safe Status
@FPLC

—

Fig. 12: Status LEDs

Indicators:
> LED "EtherCAT Run": state of EtherCAT communication
> LED "Safe Status" (duo LED): state of the module regarding its safety function
> LED "PLC ": state of the module

Explanation

LED "EtherCAT Run"

Off Init Initialising, no data exchange
Off/green, 1:1 Pre-Op Pre-operational, no data exchange
Off/green, 5:1 Safe-Op Safe operation, inputs readable
Green, on Op Operational, unrestricted data exchange
LED "Safe Status"

Green, on OK Module in safe functional state
Red, on Error Module in fail-safe state

LED "PLC "

Off - Safety application not loaded
Offlyellow, 1:1 = Loading safety application

Yellow, on = Safety application loaded

Green, on - Executing safety application

Red, on - Safety application stopped

Off/red, 1:1 = Safety application aborted
Off/green, 1:1 - Safety application in debug mode

The status LEDs are not a safety-related display. That The status display via the LEDs must not
be used alone as a safe indicator for the operating state of the module, etc.
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5.4 Operating Software

The Safety PLC is part of a distributed control system based on CODESYS. The Safety PLC is programmed
using a programming system based on CODESYS and extended by a certified plug-in (CODESYS safety
extension) which provides the safety functions.

Wrong programming and parameter setup!

» Verify that the CODESYS safety extension used for programming and parameter setup is approved
for use with the CODESYS safety runtime system version 1.2.0.

» Programming and parameter setup to take heed of the correct CODESYS user guide.
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6 Installation and Operation

> Before installing the safety module, verify that it has been transported and stored at the ambient conditions
specified in sections 4.6 Transport and Storage and 4.5 Technical Data.

> Module operation is subject to the service conditions specified in section 4.5 Technical Data.

CAUTION

Inappropriate operation!

Malfunction of the Safety PLC module.

» Only persons qualified for dealing with safety matters are allowed to add, replace and put Safety
PLC modules into operation.

»  Prior to installing, servicing or putting the Safety PLC module into operation, read the safety instruc-
tions contained in this documentation.

»  Prior to putting the module into operation, verify that all safety functions work as specified (valida-
tion of safety functions).

6.1 Mechanical Installation

ﬂ No tools are required to install and uninstall Safety PLC. Please refer to Chapter 6.1.3 to 6.1.6

Environment of installation
Protect the unit against inadmissible contamination (comply with contamination degree Il of IEC 60664-3).

A suitable means would be an IP54 enclosure, e.g. a suitable switching cabinet. Operation under condensing
humidity is NOT allowed.

WARNING

Potentially hazardous failures due to contamination!

Contaminations more severe than those described for degree of contamination Il of IEC 60664-3 may

cause potentially hazardous failures.

» Do ensure that the operating environment complies with at least IP 54, e.g. by installing the unit in a
suitable control cabinet.
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6.1.1 Mounting Position

The unit is intended for installation on a rail (to DIN EN 50022, 35 x 7.5 mm). Mount the DIN rail horizontally
and check that the module's status LEDs are at the front.

To ensure that enough air gets in through the ventilation slots, leave at least 20 mm to the top and 35 mm to

the bottom of a module and any adjacent devices or cabinet surfaces. Leave at least 20 mm of lateral dis-
tance to third-party units and cabinet surfaces.

Fig. 13: Mounting position and minimum distances, in mm

6.1.2 E-bus Connector and Module Lock

The system connectors and the module lock are located on the sides of the Safety PLC module. These con-
tact pins interconnect the modules. They supply power to the module's electronic circuitry and transfer the

EtherCAT signals. Leave the end cap from the package in place to protect the module bus connector of the
last module to the right of the terminal unit against contamination.

The integrated module lock prevents the modules from coming apart under mechanical load or vibration.
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6.1.3 To Snap on a Single Module
N

&

o]

Fig. 14: Mounting a module

1st  Push up the module against the mounting rail from below, allowing the metal spring to snap in between
mounting rail and mounting area as illustrated.

2nd Push the top of the module against the mounting wall until it snaps in.

6.1.4 To Interconnect Two Modules

1st If a module has previously been snapped on to the rail, place the next module about 1 cm away from it to the
right and snap it on.
2nd Then push the new module left towards the other module until the unlock button snaps out.

3rd  To prevent inadmissible contamination, mount the cover of the module bus connector on the rightmost mod-
ule of the FIO system.

CAUTION

Risk of injury by the module bus contacts shorting out!
A short of the module bus contacts may cause the communication with the safe module to fail.
» Verify that the end-of-bus cap is in place on the last module of a series of modules.
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6.1.5 To Disconnect Two Modules

)

Fig. 15: Disconnecting modules

1st  Push the unlock button (1) of the module you wish to remove.

2nd Push both modules about 1 cm apart.

6.1.6 To Take Down a Single Module

N ¢ N *<
N N
& N N

Fig. 16: Removing a module
1st Push the module up and against the metal spring located on the underside of the rail guide.
2nd Tip the module forward and away from the rail as shown in the illustration.
3rd  Pull the module down and out of the mounting rail.
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6.2 Electrical Installation

6.2.1 Earthing

Every module needs to be earthed by connecting the internal metal housing to functional earth which dissi-
pates HF currents and is of utmost importance to the module's immunity to noise.

HF interference is dissipated from the electronics board to the metal housing. The metal housing therefore
needs to be suitably connected to a functional earth connector.

Snapping the module on to the rail normally provides a high-conductivity earth connection between the mod-
ule housing and the rail. The rail has a high-conductivity connection to the switching cabinet which is earthed
well in itself.

If need be, the earth connection can be screwed to the front of the module (see (1) in the figure below).

Fig. 17: Earthing (example of an /0 module)

Designaiion

1 Earthing/cable shield, DIN rail,
connected by a M3x5 bolt connected to functional earth

ﬂ Earth wires should be short and have a large surface (copper mesh).

When installing production or other lines, measure the earth potential of the DIN rail as specified
in the applicable guidelines (earth test to VDE 0100) . Measuring the earth potential must show
that every protective and operational earthing is within the boundaries set by the applicable stand-
ards.

» Also consider the repeat testing frequency resulting from the hazard assessment.

6.2.2 Module Interconnection

The modules electrically interconnect by completely pushing the modules together. This automatically con-
nects the modules to both the EtherCAT bus and the system power supply. Refer to section 6.1 "Mechanical
Installation” for details about how to interconnect two modules.

6.2.3 System Power Supply to the Series of Modules

To supply the Safety PLC only modules may be used (Bus couplers, small controllers in compli-
ance with EN 61131-2), which have a polarity reversal protection for the 24V voltage supply.
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Power to each module's logical circuitry is supplied by the head module (compact controller or bus coupler)
via the modules' backplane bus. The number of stackable modules depends on the head module's power
output. A typical power output of 3 A supports up to about 20 modules. To link in a larger number of mod-
ules, just make up blocks of modules and have a separate bus coupler supply power to each of the blocks.

» Take note of the system power supply details provided in the operating instructions of the up-
ﬂ stream bus couplers or compact PLCs as well as the additional system power supply instruc-
tions in this user guide.
» Note that the maximum current supplied by the head module limits the number of modules
you may connect to a single block.

The number of interconnected modules provokes varying voltage ratios on the E-bus with refer-
ence to the module position.
» In order to provide a maximum of availability, try to place the Safety PLC module as close to
the head module as possible.

WARNING

Damage caused by wrong power supply!

Supplying the wrong voltages may damage or destroy the unit.

Preventive measures:

» Only use PELV/SELV-ready power supply units to EN50178 or EN60950-1 to supply 24 VDC to bus
couplers or compact PLCs that any Safety PLC modules are connected to.

» Only use the GND terminal to connect the power supply unit to earth (PELV system). Do not use
earthing variants that connect earth to +24V.

» To ensure that there is as little interference as possible, install a central power supply point and es-
tablish a star topology of as short wires as possible between the central point and the block of FIO
modules.
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6.3 Putting into Service

The Safety PLC may only be operated with FSoE-compliant FSoE slaves.

Whenever you work on the safety system, check that the safety functions are provided properly
afterwards.

6.3.1 Configuration

Only the operating software is used to configure the Safety PLC. The module as such does not provide op-
tions to change any of the settings.

6.4 Software Installation

6.4.1 Installing the Safety Extension

The safety extension you need for the safety PLC needs to be manually integrated in the programming sys-
tem. Once CODESYS has been installed, you just need to double-click on the installation file to also install
the CODESYS safety extension.

Another method is to run CODESYS and go to tab "Tools -> Package Manager... -> Install..." to install the
extension.

Tools | Window Help
|§ Package Manager. ..

m Library Repositary...

m Device Repositary... a
@ ‘isual Element Repository

@ Visualization Styles Repository...

Important: Note that, in either case, you need administrator privileges to install the extension.

(3]

Sort by: | Mame v| | Install... |

Update info License info

Mo license required

Mo license reguired

Updates

Search updates

>  After completing the installation, restart the CODESYS programming system.

6.4.2 Installing the Safety Device Description

Before you can use an EtherCAT module, you must first install the associated device description. This also
applies to safety modules (Safety PLC and its I/O modules).
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To install a device description (*.xml) in CODESYS, go to tab "Tools -> Gerate Repository" (Tools -> De-
vice Repository).

=]

v] [ Edit anatiuns...]

Tools | Window Help Install...

Package Manager...

Library Repositary. ..

Device Repository. .. q

— Install DTM...
Visual Element Repository

B R o

Before you can use the Safety PLC and any of the other devices in a project, mind to first of all install their
device description in the device repository.

Note: CODESYS package files and device description should always be installed by a user owning
administrator privileges.
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6.4.3 Creating a Safety Project

1st  Start CODESYS V3.

2nd On the standard CODESYS home page, go to "Basisoperationen" (Basic Operations) and click on "Neues
Projekt..." (New Project).

Start Page X

Basic Operations

1=] MNew Project...
& Open Project...

Or choose "Datei -> Neues Projekt..." (File -> New project) to create a new project.

» CODESYS

|-E New Project...  Cirl+

[ OpenProject... Ctrl+0

Close Project

Save Project Crl+5 I

3rd Pick template "Leeres Safety Projekt" (Empty Safety Project).
4th  Assign a "Name", choose a storage location, and click on "OK" to actually create the project.

i

"i% Mew Project @

Categories: Templates:
{1 Libraries
i w
] Projcis o 9

Empty project Empty Safety project

[

Standard project  Standard project with
Application Compaoser

A project containing one device, one application, and an empty implementation for PLC_PRG

5th  Add a standard PLC to the empty project by right-clicking on "[project name] -> Gerat anhangen" (Add De-
vice).
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Devices

Properties...

Add Object

O E

Add Falder. ..

| Add Device...

Edit Object

Edit IQ mapping

Edit Object With...

Device Configuration

k

6th  Pick the correct type of your standard PLC.

([ Add Device

MName:
Action:

@ Append device Insert device Plug device Update device

Device:

o

Vendor: [ <Al vendors=

Mame Yendor Yersion

#-[{) Logical devices

+-[{ PLCs

Group by category
[7] Display all versions (for experts anly)
[7] Display outdated versions

7th  To add objects to your application, right-click on "Application -> Objekt hinzufiigen" (Add Object).

-@ﬂemai

= Kuhnke_Scout_CE_x05_TV_WV (Kuhnke Scout CE x0

=& PLC Logic
= n' Application
m Library Manager

A list of available objects appears.
Click on any of the objects to add it to the application.
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Devices
= -@ Demo i
=M Kuhnke Scout CE_x05 TV WV (Kuhnke Scout CE %05 TV WV)
=2 pPLC Logic
= ulﬁ.pplica —
m Libra & cut
[ nternal_1_o Copy
Paste
Delete
Properties. ..
|T‘:| Add Object » | Alarm configuration. ..
IC3) AddFolder... Data Server...
(] EditObject DUT...
Edit Chject With. .. External File. ..
m Lagin Global Variable List...
Image Poal...
Interface...

Logical I/Os...

Logical Exchange GVL...

Metwork Variable List (Receiver)...
Metwork Variable List (Sender). ..

Persistent Variables. ..

BL4g®o® ! 06 WS E

POLL..

8th  Add a POU (programme). Assign a name, here "PLC_PRG".
9th  Add a task configuration.
10th To run the POU using the task configuration:
Click on "Aufruf hinzufuigen" (Add Call) and pick the POU from the list.
Devices > & X B startPage PLCPRG g Task x
=& Demoz (=) | configuratin |
= M Kuhnke_Scout_CE_x05_TV_WV (K
=-E] PLC Logic
n a Application Priority { 0.31 ) 1

m Library Manager Type
PLC_PRG (PRG) [Cydic "] Interval (e.g. t#200ms):  t#20ms
= @ Task Configuration
- gk
= %Sk Watchdog
PLC_PRG
ﬁ Intermal_I_Os (Scout_x_05) 7] Enable
Time (e.g. t¥200ms):
Sensitivity: 1
gk Add Call 3 Remove Call [& Change Call | & Move Up Move Down | = Open POU
POU Comment
|PLC_PRG
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Since the Safety PLC is an EtherCAT-based module, you will still need an EtherCAT master:
11th Right-click on the standard PLC you added before.
12th In the dialog, click on "Gerat anhdngen..." (Add Device).

Devices v I X |
=2 Demoi E] IE
= M [Kubnke_Scr-—-=—~=—a= s

=&l pLC Lo o Cut

Kuhnke_Scout_CE_x05 T

Paste

B > Delete

] Properties...

i Add Object
) Add Folder...

ﬁ Internz

| Add Device. ..

Ipdate Device. ..
Edit Object

Loy

Edit Object With. ..

Edit IO mapping

13th In the next dialog, choose "Feldbusse -> EtherCAT -> Master -> EtherCAT Master" (Fieldbuses -> EtherCAT
-> Master -> EtherCAT Master).

14th Click on "Gerat anhangen” (Add Device) to add the EtherCAT master to your project.

] Add Device =

Mame: EtherCAT Master
Action:

@ Append device () Update device

Device:

Vendor: [ <Al vendors = b ]

Mame Vendor Ver... i
=-[{] Fieldbusses ‘E‘
+- AN CANbus il
= pels EtherCAT
= I}E Master
ﬂj | EtherCAT Master | Kuhnke Automation T

The EtherCAT master has been added to the list of devices and, thus, to your project. The EtherCAT mas-
ter's task configuration has been create automatically.
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Devices - O X
=[5 Demo1 B2l
--m |Kuhnke_5mut_CE_xUE_T‘u'_W'u' (Kuhnke Scout CE x05 TV WYV)

=-El] PLC Logic

=1L} Application
m Library Manager
PLC_PRG (PRG)
= @ Task Configuration
= @ Task
] EtherCAT Master EtherCAT Task
& PLC_PRG
ﬁ Internal_I_Os (Scout_x_05)
[ EtherCAT_Master (EtherCAT Master)

15th Go to the settings of the EtherCAT master and choose or enter the correct Ethernet interface:
EtherCAT NIC Einstellungen (EtherCAT NIC settings) - Netzwerk durch Namen auswéhlen (Select Net-
work by Name), name of network)

[f] EtherCAT_Master X

General AutocanfigMaster/Slaves Etherchh%
Sync Unit Assignment EtherCAT NIC Setting
EtherCAT /0 Mapping Destination Address(MAC) |FF-FF-FE-FF-FFFE Broadcast  [] Enable Redundancy
Source Address (MAC) 64-D2-41-01-DB-5D
Status
Metwork Name PXAMFU1
Information i@ Select Network by MAC () Select Network by Name
Distributed Clock Options
Cycle Time 4000 ps

Bl LA

Sync Offset 20 %%

|:| Sync Window Monitoring

Sync Window 1 | ps

16th Add EtherCAT devices either manually or by searching EtherCAT.

To add EtherCAT devices manually
You can now add bus coupler(s), the Safety PLC, safety modules and other EtherCAT modules as seen by
the standard PLC:

1st Right-click on "EtherCAT_Master -> Gerat anhangen..." (EtherCAT Master -> Add Device).
2nd Choose the devices.

Kuhnke FIO Safety PLC (E 842 GB) 47
26. Mar 2019



Kendrion Kuhnke Automation GmbH Installation and Operation

Devices ~ 0 X
= 3] Demoz B3
= Kuhnke_Scout_CE_x05_TV_WV {(Kuhnke Scout CE x05 TV WW)

=81 PLC Logic

=1L} Application
m Library Manager
PLC_PRG (PRG)
= @ Task Configuration
= siﬁs Task
H] EtherCAT Master.EtherCAT Task
& PLC_PRG
ﬂj Internal_I_0Os (Scout_x_05)

[ |Eﬂ'1erCAT_Master (EtherCaTti—mt-ud
XN cut
Copy
Paste
¥ Delete
Refactoring
Properties. ..
Add Object
) AddFolder...
| Add Device...
Devices v 0 X ;A FtherfAT Master w
Bl Demot [ Add Device (==
=M Kuhnke_Scout_CE_x05_TV_WV
=B pLC Logic Name: Kuhnke_FIO_Safety_PLC
=1} Application Action:
m Library Manager @ Append device () Insert device (C) Update device
PLC_PRG (PRG)
=88 Task Configuration Device:
=g Task vendor: [ <all vendars> x)
& EtherCAT_M _
@ FLC FRG Mame Vendor Version it
ﬂj Internal_I_Os (Scout_x_05) * &i Fieldbusses =
=[] EthercaT_Master (EthercAT =@ PLcs
ﬁ Buskoppler (Buscoupler (¢ - ﬁ Safety PLCs n
Iﬁ | Kuhnke FIO Safety PLC Kendrion Kuhnke Automation GmbH Revision=16#00000003

To add devices by searching EtherCAT

There is a more convenient way of adding modules than to pick them manually.

Available EtherCAT devices can be searched for automatically and added to the project. Before you can do
so0, check that the standard PLC hosts an executable and compilable application featuring an EtherCAT
master. Also, all further modules you need have to be connected.

1st Right-click on "Application-> Einloggen" (Application -> Log On) to log on to the standard PLC.
2nd Load the application to the PLC.

3rd Right-click on EtherCAT_Master -> Gerate suchen..." (EtherCAT Master -> Find Devices) to display a
search dialog.
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- [l [EtherCAT Master (FtherCAT Macter)

N Cut

i e

Copy
Paste

Delete

Refactoring 3
Properties...

Add Object

Add Folder...

Add Device. ..

Insert Device...

| Scan For Devices,..

After the search, the dialog lists all devices found on the EtherCAT network.

Scan Devices

Scanned Devices

N ECR =X

Devicename Devicetype Alias Address
= Buskoppler Buscoupler (654.400.00) 1004
Kuhnke_FI0_Safety_PLC | Kuhnke FIO Safety PLC 0
VFIO_Si4 S02 VFIO 514/502 (694 _430.00) (Revision=16#D0000024) EI 0
WEIO_DIe_DO16 DN&D016 1ms 0.54A (654.450.03) 0
Assign Address [] Show Differences &
Scan Devices Copy All Devices to Project | | Close |

4th

Click on "Alle Gerate ins Projekt kopieren" (Copy All Devices to the Project) to automatically append all
devices below the EtherCAT master.

Kuhnke FIO Safety PLC (E 842 GB)

26.

Mar 2019

49




Kendrion Kuhnke Automation GmbH Installation and Operation

=[] EtherCAT_Master (EtherCAT Master)

= ﬁ WFIO_Buskoppler (Buscoupler (694, 400.003)

= [T Kuhnke_FIO_Safety PLC (Kuhnke FIO Safety PLC)
= Ell] Safety Logic
=4 SafetyApp
m Library Manager
= ﬂj Logical Ij0s
T vFio_s14 502 [<-VFIO_SI4 502] (VFIO SI4/S
2 safety Task
=T vFI0_S14 502 [->VFIO_S14_S02] (VFIO SI4/502 (594.430.00)
[ FsoEs (safety SDI4/S002)
[ vFIO_DIi6_DO16 (DI16/D0O16 1ms 0.54 (594,450.03))

The safety application is in the EtherCAT module of the Safety PLC. The programming system treats the
Safety PLC like a "normal" standard PLC (set active application, log on, log off).

ﬂ The CODESYS Safety manual explains how to create the safety application.

By default, a newly created empty safety project will have a user administration.
This will normally be a user called "Owner" with no password assigned.
A user must authenticate before changes made to a safety application become effective.

"

Logon

-

[l

In order to perform this action, you must logon as a user which is
member of one of the following groups:

Owner
Safety.ExtendedLevel

Please enter your user name and password:

Project/Library: Project: Scout1005_SimSiFu

User name: |

Password:

ﬂ Safety devices and safety applications should generally be protected by passwords against unau-

thorized access.
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6.4.4 Safety PLC - Logging on and Downloading an Application

Before connecting to the Safety PLC, verify that the standard PLC has an EtherCAT master with a correct
EtherCAT configuration and that the configuration has been started to ensure that the EtherCAT master is
running properly.

1st Log on and right-click on "SafetyApp"-> "Aktive Applikation" (SafetyApp -> Active Application) and make
the standard PLC the active application.

= Demol
= M Kuhnke_Scout_CE_x05_TV_WV [connected] (Kuhnke Scout CE x05 TV WW)
=&l PLC Logic
- [ Application [run]
@ o
ﬁ] Library Manager
PLC_PRG (PRG)
= @ Task Configuration
=38 EtherCAT_Master
] EtherCAT Master.EtherCAT Task
& PLC_PRG
@ Visualization
ﬂj Internal_I_Os (Scout_x_05)
=% [f] EtherCAT_Master (EtherCAT Master)
= ﬂj VFIO_Buskoppler (Buscoupler (694.400.00))
=3[ safetyPLC (Kuhnke FIO Safety PLC)
= @1] Safety Logic
=13 |safety

(i) Libr dh Cut
= [ Log Copy
i Paste 1] (VFIO SI4/502 (594.430.00))
4 o P Delete
@ Saf = _
=-#:[T vFI0 514 5 Hilial e 502 (694.430.00))
([ FsoEs (&3 Add Object »
[ VFIODI6 | =  addFolder... 450.03))
] Edit Object
Edit Object With. ..

| Set Active Application
&8 Login

2nd Right-click on "SafetyApp" -> "Einloggen" (SafetyApp -> Log On) to log on to the Safety PLC.
3rd Load the application to the PLC.
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s
Lo

E
1

Cut

o <

Copy

Paste

5 ws

|8 EiE g

= Delete
i saf

[ vrio_ s14 5

[ Fsoes (
[ vFIo_pIis_

Add Object

Edit Object

Properties...

Add Folder,..

Edit Object With...

0] (WMFIO 514

14/502 (694.430.

34,450.03))

)

Login

When logging on, you will be prompted for the Safety PLC's serial number. This is to avoid changing the

Safety PLC and the application it hosts by mistake.

P

Connect to safety device

Device object: SafetyPLC
Device type: WFIO Safety PLC
Mode name
Current: VFIO SﬂfEt!.l' PLC
New: VFIO Safety PLC

Instance identification:

Please confirm to connect to the safety device.

Flease enter serial number

-

==

oK ] [ Cancel

4th  Right-click on "SafetyApp" -> Start to start the application.
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=43 [{] EtherCAT_Master (EtherCAT Master)
= ﬂj WFIO_Buskoppler (Buscoupler (694, 400.00))
= ﬁ SafetyPLC [connected] (Kuhnke FIO Safety PLC)
= Ell] Safety Logic

- 1| safety.
¥ cut
i Lior
Ep:
= [ Log Copy
@ Paste 03] (VFIO 514/502 (594.430.(
i POL > Delete
£ safe -
= Properties. ..
=3[ vrFIO 514 50 4/502 (594.430.00))
ﬁ FSOES (5 5 Add Object k
[ vFIO_DI16 0 5)  Add Folder... 4,450.03))
] Edit Object
Edit Ohject With...
ig Logout
p Start

6.4.5 Safety PLC — FSoE (Safety over EtherCAT)

The Safety PLC uses FSoE (Safety over EtherCAT) to communicate with other safety modules. In this setup,
the Safety PLC is the FSoE master, while the other safety modules are FSOE slaves. The master uses a
unique ID to address the FSoE slaves. This will only work if the FSoE slave ID is unique within the EtherCAT
network and has been added to both the master's and slave module's configuration. (Refer to the user guide
of the slave module concerned to learn how to set the module's FSoE ID)

6.4.6 Setting the FSoE Slave IDs in the Safety PLC
Run CODESYS Safety to configure the FSoE (Safety over EtherCAT) slave modules in the Safety PLC.

=[] EtherCAT_Master (EtherCAT Master)
= m VFIO_Buskoppler (Buscoupler (594.400.00))
=-[ safetyPLC (Kuhnke FIO Safety PLC)
= @ﬂ safety Logic
=} safetyApp
m Library Manager
= ﬂj Logical Ij0s
(T |vFI0_S14 502 [<-VFIO 514 502] (VFIO SI14/5(
£ pou
& safety Task
=-[[ vFIo_sI14_502 [->VFID_SI4_502] (VFIO SI4/S02 (694.430.00)
(M FsOEs (safety SDI4/SD02)
[ vFIo_DIi6_DO16 (DI16/DO16 1ms 0.54 (634.450.03))

To configure the FSoE slave modules, go to the Safety PLC and find the "Logical I/0s" entry under "Safe-

tyApp". This is where the system automatically adds the slave modules and where you can adapt them man-
ually.
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Enter the FSoE slave's configuration in the associated Configuration dialog by assigning a unique FSoE ad-
dress and Connection ID to the module.

([ vFIO_S14_502 x

safe configuration In Work
Mame Value
o )
‘ If0 mapping FSoE address )

Information

Connection ID 4

6.5 Validation of Safety Functions

After completing the installation and setting up the safety application, the latter must be checked for proper
operation within the overall system.

DANGER

Validation of Safety Functions!
The implementation and operation of safety applications within the overall system must be checked.
» Validation of the complete system according to the CODESYS Safety User Manual

6.6 Diagnosis
6.6.1 Self-test

When system voltage is supplied to the Safety PLC, it initially runs a complete system test. Only if this sys-
tem test is passed will the module be able to operate and first of all change to its "fail-safe" state.

This state is indicated by LED "Safe Status" lighting up red.
The fail-safe state of the Safety PLC will be retained until the required internal tests have been passed.

After the self-test, the Safety PLC will start the safety application from its memory. This defines as the safe
functional state which is indicated by LED "Safe Status" lighting up green.

The module will retain its fail-safe state if it fails to qualify for the safe state, e.g. because of errors in the ap-
plication's module setup.

In normal op mode, the system test will be repeated as a cyclic background process. Any errors encountered
will again provoke the fail-safe state and an entry in the CODESYS log.

6.6.2 Safety PLC Module Errors

The cyclic self-tests performed in compliance with the standards listed in the certificate will discover all errors
in due time and change the module state to "fail-safe".

This is indicated by LED "Safe Status" lighting up red (see section 5.3 Status LEDS).

The status LEDs are not safety-related displays. That The status display via the LEDs must not be
used alone as a safe indicator for the operating state of the module, etc.

DANGER

Use of devices in a fail-safe state
Subsequent faults may provoke a hazard.

» When an error occurs, have the actions taken required to find and remove the root cause and initi-
ate any replacements, as appropriate.
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In the case of serious module-internal errors of the Safety PLC, Kendrion Kuhnke Automation
GmbH must be informed.

6.6.3 Temperature Faults

The module is designed for ambient temperatures between 0 °C and max. 55 °C and for being installed in a
control cabinet. The Safety PLC features an internal temperature sensor. If the temperature is out of the
specified range during operation, the state will change to "fail-safe". You cannot start the module if the tem-
perature is out of the specified range.

CAUTION

Do not operate the Safety PLC module out of the specified range!
High or low temperature fault.
» Operate the module under the ambient conditions listed in section Technical Data only.

CAUTION

Use of the internal temperature sensor for safety applications is not permitted!
Non-safety-oriented temperature sensor.
» The internal temperature sensor must not be used for the realization of safety applications.

6.6.4 Error Handling and Logging

The Safety PLC's diagnostic LEDs indicate faults and errors according to the type of fault detected. The log
screen of the relevant Safety PLC in the programming system will also list all error messages. Furthermore,
the standard PLC can use COE objects (see object dictionary) to retrieve errors from specific registers of the
Safety PLC.

6.7 Resetting / Acknowledging Errors

Safety PLC errors are distinguished as errors of the Safety PLC as such and errors occurring when com-
municating with sensors and actuators or the errors provoked by sensors and actuators.

Safety PLC errors can be acknowledged by restarting the PLC only. To restart the PLC, perform a PowerCy-
cle (supply off/on) at the head module.

A loss of communication or errors of sensors or actuators provoke an error of the associated safety module.
They can be detected via the safety application and acknowledged by the associated reset inputs of the
modules (e.g. the FSoE master). During that time, the Safety PLC will retain its safe functional state.

PowerCycle

After removing the cause of an error, reset the Safety PLC by performing a PowerCycle at the head module
(power off/on).

WARNING

Resetting / acknowledging may cause a dangerous state!

» Before acknowledging an error, verify that its cause has been removed professionally.

» Before acknowledging an error, verify that acknowledging it will not cause a dangerous machine
state.

» Atthe machine or system planning stage, make sure that acknowledging an error must not be pos-
sible unless you have full view of the danger zone.
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6.8 Maintenance / Servicing

6.8.1 General

Only qualified persons are allowed to work on the Safety PLC.

CAUTION

Unsafe and undefined machine state!
Destruction or malfunction of the Safety PLC.

»  The module housing must not be opened.

» The module must not be repaired.

» Do not plug, mount, unplug or touch the connectors during operation!

»  Turn off all power sources before working on the modules. This also applies to any peripherals con-
nected such as encoders, programming devices with external power source, etc.

» Check that none of the ventilation slots is covered.

6.8.2 Servicing

For the specified service life, the Safety PLC needs neither servicing nor any other actions. For this reason,
no spare parts are available.

During operation and storage, the Safety PLC must be protected against contamination, outside the usual
contamination occurring in the defined ambient conditions. If the module has been exposed to unauthorized
contamination, it must not be used, cleaned or further operated.

DANGER

Risk of injury caused by an unsafe and undefined machine state!

>
>

You are not allowed to operate an inadmissibly contaminated module.
Neither is cleaning the unit allowed.

6.9 Replacing a Safety PLC

CAUTION

Risk of injury caused by an unsafe and undefined machine state!
Risk of injury.

>

>

Before replacing a Safety PLC module, turn off the power supply of the Safety PLC and the mod-
ules connected to it.

After replacing a Safety PLC module and before restarting the machine or system, verify that the
associated safety function is provided properly.

6.9.1 Replacement Procedure

Preparation

1st

2nd

Verify that the new module meets the following requirements:

-  Same type of device

-  Same or higher version, see section 5.1 Labelling and Identification.
Enable the safe system or machine state.
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3rd  Turn off the power supply to the head module and the modules connected to it.

Remove the old module

4th  Split up the line of FIO module, as necessary: press the unlock button of the adjacent module and push the
two modules about 1 cm apart (refer to the instructions of the other module).

5th  Push the module up and against the metal spring located on the underside of the rail guide (see section
6.1.6 To Take Down a Single Module).

6th  Tip the module forward and away from the rail.
7th  Pull the module down and out of the mounting rail.

Install and program the new module

8th  Place the new module at the position in the line of module previously occupied by the old module (see sec-
tion 6.1.3 To Snap on a Single Module).

9th Load the validated new safety application.

6.9.2 Restart

1st  Verify that the machine or system is in a safe state and that there is nothing and nobody in the danger zone.
2nd Turn the power back on.

3rd  After replacing the safety module, repeat the initial startup procedure (see section 6.3 Putting into Service).
4th  Check all safety functions after replacing a module.

6.10 Durability

The Safety PLC modules have a design life of max. 20 years after the date of manufacture (see section 5.1
Labelling and Identification).

WARNING

Risk of injury caused by using a module beyond its design life!

» Remove the module from service when it is at the end of its design life at the latest (see section
6.10.3 Taking out of Service).

6.10.1 Repairs / Customer Service

You are not allowed to open a Safety PLC module or to attempt any other repairs. If you do, proper operation
of the Safety PLC module is no longer warranted.

In case a module failure is potentially hazardous, return the module to the manufacturer where the
fault will be identified.

Refer to section 8 Sales & Service for the manufacturer's address.

6.10.2 Warranty

The statutory period and conditions of warranty apply. Warranty expires if unauthorised attempts are made
to repair the unit / product or any other intervention is performed.

6.10.3 Taking out of Service

The manufacturer of the machine or system specifies the procedure of taking the product out of service.
»  Verify that used modules taken out of service are provided for further use as intended.
> Comply with the storage and transport requirements specified in the Technical Data section.
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6.10.4 Disposal

> Dispose of the safety system in conformity with the applicable environmental regulations and make sure that
the modules are not returned into circulation.

> Treat the packaging as recyclable paper and cardboard.
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7 Appendix
7.1 Safety Ratings of the Safety PLC

The table below lists the safety ratings of the Safety PLC. All components involved in the safety function
must be taken into account in order to assess whether the desired safety level is achieved.

Highest safety integrity level to EN SIL3

62061:2010

Highest safety integrity level to IEC SIL3

61508:2010

Highest performance level Cat. 4/PL e

to EN ISO 13849-1:2015

Hardware fault tolerance (HFT) 1

(IEC 61508:2010/EN ISO 13849- (a fault of the application need not cause the safeguard to fail)

1:2015)
Ambient temp. 25 °C Ambient temp. 55 °C

Probability of failure on demand 257*10° 299*10-°

(PFDavg), proof test interval: 20 (2.57% of entire PFDavg at 10 (2.99% of entire PFDavg von 103

years (IEC 61508:2010) bei SIL3) at SIL3)

Probability of failure per hour (PFHq4),  3.04 * 1010 3.55*10-10 1/h

proof test interval: 20 years (IEC (0.3 % der gesamten PFH at (0.36 % der gesamten PFH at 10 -

61508:2010) 10 7 bei SIL3) 7 bei SIL3)

Diagnostic coverage (DC)to EN ISO  97.24 % 96.9 %

13849-1:2015 (Is rounded to 99% according (Is rounded to 99% according to
to EN ISO 13849-1: 2015) EN ISO 13849-1: 2015)

Safe failure fraction (SFF) 98.6 % 98.49 %

MTTFD to EN ISO 13849-1:2015 225 years 221 years

Kuhnke FIO Safety PLC (E 842 GB) 59

26. Mar 2019



Kendrion Kuhnke Automation GmbH Appendix

7.2 Communication Objects
7.2.1 Device Type 1000n

Name Device Type
Index 1000h

Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNED32
Access Read only
PDO Mapping No

Value Range Set

Default Value 89130000h

7.2.2 Error Register 1001n

Name Error Register

Index 1001h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No, TX-PDO

Default Value 00h

Bit analysis to CANopen DS301.:
Bit7 | Bit6 Bit5 Bit4 Bit3 Bit2 Bitl BitO
0x80 | Ox40 | Ox20 | 0x10 | Ox08 0x04 0x02 | 0x01
n.i. n.i. n.i. n.i. temperature er- | voltage error n.i. other faults
ror

7.2.3 Device Name 1008y,

Name Device Name
Index 1008h

Object Code VARIABLE

No. of Elements 0

Data Type VISIBLE_STRING
Access Read only

PDO Mapping no

Value Range Set

Subindex 0 of this object contains the string length. Subindex 1 contains each of the characters. The charac-
ter string has no terminating zero.
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7.2.4 Hardware Version 1009

Name Manufacturer Hardware Version
Index 1009h

Object Code VARIABLE

No. of Elements 0

Data Type VISIBLE_STRING

Access Read only

PDO Mapping No

Value Range Set

Default Value 12E3030 h (1.00)

7.2.5 Software Version 100An

Name Software Version
Index 100Ah

Object Code VARIABLE

No. of Elements 0

Data Type VISIBLE_STRING
Access Read only

PDO Mapping No

Value Range Set

Default Value 1.2.0

7.2.6 CANopen 'Restore Default Parameters' obj. 1011n

Name CANopen 'Restore Default Parameters' obj.
Index 1011h
Object Code RECORD
No. of Elements 5
Name Number of entries
Subindex 00h
Data Type UNSIGNEDS
Access Read only
PDO Mapping No
Default Value No default
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Name Restore all parameters (not used)
Subindex 01lh

Data Type UNSIGNED32

PDO Mapping No

Name Restore communication parameters (not used)
Subindex 02h

Data Type UNSIGNED32

PDO Mapping No

Name Restore application parameters (not used)
Subindex 03h

Data Type UNSIGNED32

PDO Mapping No

Name Restore file system

(write 0x64616F6C; comes into effect on next power cycle; request will be
cleared after 1 min if no power cycle occurs)

Subindex 04h

Data Type UNSIGNED32

Access Read / write

PDO Mapping No

Name Delete Boot Application

(write 0x64616F6C; comes into effect on next power cycle; request will be
cleared after 1 min if no power cycle occurs)

Subindex 05h

Data Type UNSIGNED32
Access Read / write
PDO Mapping No

7.2.7 ldentity Object 1018h

Name Identity Object
Index 1018h
Object Code RECORD
No. of Elements 4
Data Type IDENTITY
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Name Number of entries

Subindex 00h

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

Default Value 4

Name Vendor ID

Subindex 01h

Data Type UNSIGNED32

Access Read only

PDO Mapping No

Name Product Code

Subindex 02h

Data Type UNSIGNED32

Access Read only

PDO Mapping No

Name Revision

Subindex 03h

Data Type UNSIGNED32

Access Read only

PDO Mapping No

Name Serial Number

Subindex 04h

Data Type UNSIGNED32

Access Read only

PDO Mapping No

Units YYYYYY mmmm ddddd nnnnnnnnnnNNNnnNn

6 bits 4 bits 5 bits 17 bits

Year 2014 is coded as '0".

Value Range 14 01 01 00001 (0x00420001) ...
77 12 31 99999 (OXFF3F869F)

Example 16052300001 1 0x096E0001

The object contains details of the manufacturer, the product code and the revision and serial numbers.
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7.2.8 Error Settings (Not Used) 10F 1

Name Error Settings (Not Used)
Index 10F1h

No. of Elements 0

Access Read only

PDO Mapping No, TX-PDO

7.2.9 Sync Manager Type (Not Used) 1C00x

Name Sync Manager Type (Not Used)
Index 1C00h

No. of Elements 0

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

7.2.10 SM out Par (Not Used) 1C32x

Name SM out Par (Not Used)
Index 1C32h

No. of Elements 0

Data Type UNSIGNEDS

Access Read only

PDO Mapping No

7.2.11 SM in Par (Not Used) 1C33;,

Name SM in Par (Not Used)
Index 1C33h
No. of Elements 0
Data Type UNSIGNEDS
Access Read only
PDO Mapping No
Kuhnke FIO Safety PLC (E 842 GB) 64

26. Mar 2019



Kendrion Kuhnke Automation GmbH Appendix

7.3 Manufacturer-specific Objects

7.3.1 MC 1: Reference Voltage [mV] 2000n

Name MC 1: Reference Voltage [mV]
Index 2000h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Units mV

Value Range 0...65535

Default Value No default value

7.3.2 MC 1: 5V Supply Voltage [mV] 2002+

Name MC 1: 5 V Supply Voltage [mV]
Index 2002h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Units mV

Value Range 0 ... 65535

Default Value No default value

7.3.3 MC 1: 3.3 V Supply Voltage [mV] 2003h
This is the supply voltage of MC 2 measured by MC 1.

Name MC 1: 3.3 V Supply Voltage [mV]
Index 2003h
Object Code VARIABLE
No. of Elements 0
Data Type UNSIGNED16
Access Read only
PDO Mapping No
Units mV
Value Range 0 ... 65535
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Default Value No default value

7.3.4 Temperature Sensor [0.01 °C] 2006n

Name Temperature Sensor [0.01 °C]
Index 2006h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16

Access Read

PDO Mapping No

Units 0.01°C

Value Range 0 ... 8000

Default Value No default value

7.3.5 MC 1: Error Code 2007h

Name MC 1: Error Code
Index 2007h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32
Access Read

PDO Mapping No

The table below explains every entry in object 2007x "Err.code”.

e

0x0000 OK: No error

0x0001 HWT_PARAMETER_ERROR
Hardware test parameter error

2 0x0002 HWT _INIT_ERROR
Hardware test initialisation error

100 0x0064 HWT_ MEM_MARCHC ERROR
Hardware test RAM check error

101 0x0065 HWT_ MEM_GALPAT_ERROR
Hardware test RAM check error

200 0x00C8 HWT_STACK_UNDERFLOW_ERROR
Hardware test stack underflow

201 0x00C9 HWT_STACK _OVERFLOW_ERROR
Hardware test stack overflow

300 0x012C HWT_CPU_ERROR
Hardware test CPU error

400 0x0190 WT_FW_ERROR
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I N

Hardware test firmware error

500 O0x01F4 HWT_FWINTERFACE_ERROR
Hardware test firmware error

504 0x01F8 HWT_ADC_ERROR: Test handler: error in ADC value range checks
Hardware test AD converter error

505 0x01F9 HWT_DMA ERROR: Test handler: error in DMA check
Hardware test DMA checksum error

506 O0x01FA HWT_CRC_ERROR: Test handler: error in CRC check
Hardware test checksum error

507 0x01FB HWT_TIMER_ERROR: Test handler: error in timer check
Hardware test CPU timer error

508 0x01FC HWT_CLOCK_ERROR: Test handler: error in clock signal check
Hardware test CPU clock error

512 0x0200 TIMEOUT_ERR: [12C communication timeout detected
Software timeout detected

513 0x0201 OUT_OF _RANGE_ERR: Parameter or value out of allowed range.
Parameter range error

514 0x0202 OVERWRITE_ERR: Register buffer data overwrite occured.
Data overflow

516 0x0204 PRG_CNTRL_ERR: Program sequence control detected error.
Programme sequence error

517 0x0205 “Soft-Error” detected
Software error

528 0x0210 INIT_ERROR: Initialization error
Initialisation error

592 0x0250 ASSERT_TRUE_ERR: Assertion for expression yields "true" failed.
Asserting "true” failed

593 0x0251 ASSERT_NOT_NULL_ERR: Assertion for unequal to NULL failed.
Asserting unequal to "NULL” failed

594 0x0252 ASSERT_GE_ERR: Assertion for ">=" comparison failed.
Asserting ">=" failed

595 0x0253 ASSERT_GT_ERR: Assertion for ">" comparison failed.
Asserting "> failed

596 0x0254 ASSERT_LE ERR: Assertion for "<=" comparison failed.
Asserting "<=" failed

597 0x0255 ASSERT_LT_ERR: Assertion for "<" comparison failed.
Asserting "<” failed

598 0x0256 ASSERT_NE_ERR: Assertion for "<>" comparison failed.
Asserting "<>” failed

599 0x0257 ASSERT_EQ_ERR: Assertion for "=" comparison failed.
Asserting "=" failed

600 0x0258 ASSERT_FALSE_ERR: Assertion for expression yields "false" failed.
Asserting "false” failed

672 0x02A0 MRAM not initialized

673 0x02A1 MRAM_READ_ERR: MRAM read error.

676 0x02A4 MRAM_CORRUPT_PAGE_SIZE: Invalid MRAM page size.

677 0x02A5 MRAM_CRC_ERR: MRAM data CRC check failed.
MRAM checksum error (CRC error)

688 0x02B0 LZS logging not yet initialized.
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I N

689 0x02B1 LZS logging initialized.

692 0x02B4 LZS world time timer initialized.

696 0x02B8 Request file system reset.

697 0x02B9 Request deleting boot app from file system.

698 0x02BA Boot app deleted from file system.

699 0x02BB Reset of file system activated.

700 0x02BC System request cancelled due to timeout.

768 0x0300 RESET_LOW_POWER: Reset due to low power supply.
769 0x0301 RESET_WINDOW_WD: Reset due to window watchdog.

770 0x0302 RESET INDEPENDENT_WD: Reset due to independent watchdog.
Reset by watchdog timer

771 0x0303 RESET_SW: Reset due to software reset.
772 0x0304 RESET_POWER_ON_DOWN: Reset due to power up or down.
773 0x0305 RESET_NMI: Reset due to non-maskable interrupt.

774 0x0306 RESET_BROWNOUT: Reset due to brown out detection.
Reset by low CPU voltage

775 0x0307 RESET_NO_REASON: Reset for unknown reason.

778 0x310 Reset for invalid reason

1024 0x0400 ADC_REF_LOW: AD converter reference voltage too low.
1025 0x0401 ADC_REF_HIGH: AD converter reference voltage too high.

1028 0x0404 ADC_5V_LOW: 5V supply voltage too low. (ErrReg: 4)
4)

1029 0x0405 ADC_5V_HIGH: 5V supply voltage too high. (ErrReg: 4)
Upper limit of internal 5 V supply exceeded

1030 0x0406 ADC_3 3V_LOW: 3.3V supply voltage too low.
Power below internal 3.3 V limit

1031 0x0407 ADC_3 3V_HIGH: 3,3V supply voltage too high.
Upper limit of internal 3.3 V supply exceeded

1032 0x0408 ADC_TEMP_LOW: On-chip temperature too low. (ErrReg: 8)
Ambient temperature too low

1033 0x0409 ADC_TEMP_HIGH: On-chip temperature too high. (ErrReg: 8)
Ambient temperature too high

1034 0x040A ADC_CURR_HIGH: Total output current too high. (ErrReg: 2)
1036 0x040C Temperature at warning limit
1037 0x040D Data value not yet available

1280 0x0500 LINE_TIMEOUT: Invalid sync line level from base board
Sync line level monitoring timeout

1282 0x0502 TIMEOUTTIMERERR: Timeout timer error occurred

1283 0x0503 HW_REVISION_ERROR: Invalid HW revision detected (the SW currently running is
not designed for this HW revision)
Wrong hardware / PCB revision (current software not intended for this HW revision)

1664 0x0680 MC1_NOTREADY: MC1 has not yet initiated communication with MC3
2048 0x0800 BCOM_NOTREADY: Base board communication not ready / operational
2049 0x0801 BCOM_BUSY: Base board communication is busy

2050 0x0802 BCOM_NONEWDATA: No new data received from base board
Communication with base board — no new data received
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I N

2051 0x0803 BCOM_CRCERR: Base board communication CRC error detected
Communication with base board — CRC error

2052 0x0804 BCOM_BITERR: Communication with base board — shifted bits detected
Communication with base board — shifted bits

2304 0x0900 XCOM_NOTREADY: Communication with safety partner microcontroller (MC) not
ready / operational

2305 0x0901 XCOM_BUSY: Safety parther MC communication is busy

2306 0x0902 XCOM_NONEWDATA:
Communication with safety partner MC — no new data received

2307 0x0903 XCOM_CRCERR: Safety partner communication CRC error detected
Communication with safety partner MC — CRC error

2336 0x0920 3S RTS background communication with safety partner MC not operational
2337 0x0921 3S RTS background communication with safety partner is busy

2338 0x0922 3S RTS background communication has not yet received new data from safety part-
ner MC

2339 0x0923 3S RTS background safety partner communication CRC error detected

2340 0x0924 BGCOM_QUEUEERR: 3S RTS background safety partner communication queue er-
ror detected

2352 0x0930 3S RTS VM-to-safety partner MC communication not operational yet
2353 0x0931 3S RTS VM-to-safety partner communication is busy

2354 0x0932 3S RTS VM communication has not received new data from safety partner MC
2355 0x0933 3S RTS VM-to-safety partner communication CRC error detected
2560 0x0A00 12C_TIMEOUT: 12C communication timeout detected

2561 0x0A01 12C_BUSY: 12C bus is busy

2976 0xOBAO FSoE Master finished initialization

2977 OxOBA1 FSoE Master is shutting down

3329 0x0DO01 MC1_ID_INVALID: Identifying MC 1 failed

3330 0x0D02 MC2_ID_INVALID: Identifying MC 2 failed

3331 0x0D03 MC3_ID_INVALID: Identifying MC 3 failed

3841 Ox0F01 FLASH_TIMEOUT: FLASH write operation timeout

3842 0x0F02 FLASH_LOCKED: FLASH write operation failed because "LOCK" bit could not be re-
set

3851 O0xO0F0B FLASH_BUSY: FLASH operation busy
Flash programming sequence error

3854 OxOFOE FLASH_ERROR: FLASH operation error
Programming the FLASH memory failed

7.3.6 MC 1: Error Line 2008

Name Err.line
Index 2008h
Object Code VARIABLE
No. of Elements 0
Data Type UNSIGNED16
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Access

PDO Mapping

Read
No

7.3.7 MC 1: Error Module 2009

Error Module

Name

Index

Object Code

No. of Elements

Data Type

Access

PDO Mapping

2009h

VARIABLE

0

UNSIGNEDS

Read
No

The table below explains every entry in object 2009h "Err.module”.

i Liec Lo

OBJ_UNKNOWN_ID

12

16

20

24

28

29

30

52

56

58

72

74

88

0x00

0x04

0x08

0x0C

0x10

0Ox14

0x18

0x1C

0Ox1D

Ox1E

0x34

0x38

0x40

0x48

0x50

0x58

Error from module:

unknown

OBJ_PRGCONTROLTASK_ID

Error from module:

CProgramControlTask.cpp

OBJ_SAFETYHAL_ID

Error from module:

CSafetyHal.cpp

OBJ_MAINTASK_ID

Error from module:

CMainTask.cpp

OBJ_PRGCONTRLTASK_ID

Error from module:

CProgramControlTask.cpp

OBJ_SYNCSAFETYPARTNER_ID

Error from module:

OBJ_XCOM_ID

Error from module:

OBJ_BBCOM_ID

Error from module:

OBJ_VMCOM_ID

Error from module:

OBJ_BGCOM_ID

Error from module:

OBJ_HELPER_ID

Error from module:

CSyncSafetyPartner.cpp
CXcom.cpp
CBBCom.cpp

CVMCom module
CBGCom module

CHelper.cpp

OBJ_SYNCLINE_ID

Error from module:

CSyncSafetyPartner.cpp - sync()

OBJ_TESTHANDLER_ID

Error from module:

CTestHandler.cpp

OBJ_DIAGNOSTIC_ID

Error from module:

CDiagnostic.cpp

OBJ_FSOEMASTER_ID

Error from module:

CHAL_FSoEMaster_Template.cpp

OBJ_INTHANDLER_ID
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I N

Error from module: InterruptHandler.cpp

192 0xCO OBJ_SPI_ID

Error from module: CSpi.cpp
193 0xC1 OBJ_TIMER_ID

Error from module: CTimer.cpp
194 0xC2 OBJ_BACKUPSRAM_ID

Error from module: CBackupSRam.cpp
195 0xC3 OBJ_PWR_ID

Error from module: CPwr.cpp
196 0xC4 OBJ_RCC_ID

Error from module: CRcc.cpp
197 0xC5 OBJ_GPIO_ID

Error from module: CGpio.cpp
198 0xC6 OBJ_DMASTREAM_ID

Error from module: CDmaStream.cpp
199 0xC7 OBJ_ADC_ID

Error from module: CAdc.cpp
200 0xC8 OBJ WD _ID

Error from module: CWatchdog.cpp
201 0xC9 OBJ_FLASH_ID

Error from module: CFlash.cpp
202 OxCA OBJ_CRC_ID

Error from module: CCrc.cpp
203 0xCB OBJ_I12C _ID

Error from module: Cl2c.cpp
208 0xDO OBJ_APPIF_ID

Error from module: CECatApplinterface.cpp

7.3.8 MC 1: Error Class 200An

Name Err.class
Index 200Ah
Object Code VARIABLE
No. of Elements 0

Data Type UNSIGNEDS8
Access Read

PDO Mapping No

The table below explains every entry in object 200Ah "Err.class".

(1d | Explanation

0 No error
1 Serious or synchronization error
2 Internal communication error
3 I/O error
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4 TestHandler error

7.3.9 MC 1: System Uptime [s] 200Cy,

Name System Uptime [s]
Index 200Ch

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32
Access Read

PDO Mapping No

Units S

Default Value No default value

7.3.10 Read / Write World Time [s] (LOG Time) 200D

Name Read / write world time [s] (GMT, UTC)
Index 200Dh

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read / Write

PDO Mapping No

Units S

Default Value No default value

7.3.11 MC 3: 3.3 V Supply Voltage [mV] 2013n

Name MC 3: 3.3 V Supply Voltage [mV]
Index 2013h

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Units mV

Default Value No default value

7.3.12 Temperature Warning 2016k
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Name Temperature warning
Index 2016h
Object Code VARIABLE
No. of Elements 0
Data Type UNSIGNEDS
Access Read
PDO Mapping No
Value 0°C —55°C =0; <0°Cor >55°C =1
Default Value No default value

7.3.13 MC 1: LZS Componentld 2017x
Name MC 1: LZS Componentld
Index 2017h
Object Code VARIABLE
No. of Elements 0
Data Type UNSIGNED32
Access Read
PDO Mapping No
Default Value No default value

7.3.14 MC 1: LZS Fileld 2018h
Name MC 1: LZS Fileld
Index 2018h
Object Code VARIABLE
No. of Elements 0
Data Type UNSIGNED32
Access Read
PDO Mapping No
Default Value No default value

7.3.15 MC 1: LZS Line 2019h
Name MC 1: LZS Line
Index 2019h
Object Code VARIABLE
No. of Elements 0
Data Type UNSIGNED32
Access Read
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PDO Mapping No
Default Value No default value

7.3.16 MC 1: Read Number of CORA Test Cycles 201Ax

Name MC 1: Read Number of CORA Test Cycles
Index 201Ah

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value No default value

7.3.17 MC 1: Read Number of File System Test Cycles 201Bx

Name MC 1: Read Number of File System Test Cycles
Index 201Bh

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value No default value

7.3.18 MC 1: Read Number of IAR Test Cycles 201Ch

Name MC 1: Read Number of IAR Test Cycles
Index 201Ch

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED32

Access Read

PDO Mapping No

Default Value No default value

7.3.19 SW Build No 210An

Name SW Build No
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Index 210Ah

Object Code VARIABLE

No. of Elements 0

Data Type UNSIGNED16
Access Read

PDO Mapping No

Default Value No default Value

7.3.20 Read MC 3 Error 2210,

Name Read MC 3 Error
Index 2210h
Object Code RECORD
No. of Elements 3
Name Number of Entries
Subindex 00h
Data Type UNSIGNEDS
Access Read only
PDO Mapping No
Default Value 3
Name MC 3: Error Number
Subindex 01lh
Data Type UNSIGNED16
Access Read only
PDO Mapping No
Name MC 3: Error Line
Subindex 02h
Data Type UNSIGNED16
Access Read only
PDO Mapping No
Name MC 3: Error Module
Subindex 03h
Data Type UNSIGNEDS
Access Read only
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PDO Mapping No

7.3.21 Read MC 1 Runtimes 22205

Name RunTime MC 1

Index 2220h

Object Code RECORD

No. of Elements 6

Name Number of Entries

Subindex 00h

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

Default Value 6

Name Runtime Main Loop [ps]
(designation in XML file: Act RT)

Subindex 01lh

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Maximum of Main Loop Runtime [us]
(designation in XML file: Max RT)

Subindex 02h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Application Cycle Time (Par. from PS) [ps]
(designation in XML file: App Cycle)

Subindex 03h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Application Runtime [ps]
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(designation in XML file: App RT)

Subindex 04h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Application CORA Time [us]
(designation in XML file: CORA RT)

Subindex 05h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Reserved [ps]

Subindex 06h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

7.3.22 MC 3 Main Loop Cycle Time and Max Cycle Time 2221y,

Name MC 3 Main Loop Cycle Time and Max Cycle Time [us]
(designation in XML file: RunTime MC3)

Index 2221h

Object Code RECORD

No. of Elements 2

Name Number of Entries

Subindex 00h

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

Default Value 2

Name Runtime Main Loop [ps]
(designation in XML file: Act RT)

Subindex 01lh

Data Type UNSIGNED16

Access Read only
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PDO Mapping No

Name Maximum of Main Loop Runtime [us]
(designation in XML file: Max RT)

Subindex 02h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

7.3.23 Free Disk Space / App Size Information 2230

Name Free Disk Space / App Size Information
(designation in XML file: Free Disk Space)

Index 2230h

Object Code RECORD

No. of Elements 4

Name Number of Entries

Subindex 00h

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

Default Value 4

Name Actual Local Free Disk Space [Byte]
(designation in XML file: Local)

Subindex 01h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Actual Global Free Disk Space [Byte]
(designation in XML file: Global)

Subindex 02h

Data Type UNSIGNED16

Access Read only

PDO Mapping No
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Name Actual Application Code Size [Byte] — max.400kByte
(designation in XML file: App Code)

Subindex 03h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Actual Application Data Size [Byte] — max.112kByte
(designation in XML file: App Data)

Subindex 04h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

7.3.24 ST CPU Chip Id MC 1 (96-bit Serial Number) 5001,

Name ST CPU Chip Id MC 1 (96-bit Serial Number)
(designation in XML file: |d MC1)

Index 5001h

Object Code RECORD

No. of Elements 4

Name Number of Entries

Subindex 00h

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

Name MC 1 Id Received : 1 - OK, O - failed
(designation in XML file: Id rx from MC1)

Subindex 01h

Data Type UNSIGNED16

Access Read only

PDO Mapping No

Name Id Bits 0...31
(designation in XML file: Bits 0-31)

Subindex 02h

Data Type UNSIGNED16
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Access Read only
PDO Mapping No
Name Id Bits 32...63
(designation in XML file: Bits 32-63)
Subindex 03h
Data Type UNSIGNED16
Access Read only
PDO Mapping No
Name Id Bits 64...95
(designation in XML file: Bits 64-95)
Subindex 04h
Data Type UNSIGNED16
Access Read only
PDO Mapping No

7.3.25 ST CPU Chip Id MC 3 (96-bit Serial Number) 5003

Name ST CPU Chip Id MC 3 (96-bit Serial Number)
(designation in XML file: I|d MC3)

Index 5003h

Object Code RECORD

No. of Elements 4

Name Number of Entries

Subindex 00h

Data Type UNSIGNEDS8

Access Read only

PDO Mapping No

Default Value 4

Name Identification State: 1 - OK, O - failed
(designation in XML file: Id valid)

Subindex 01h

Data Type UNSIGNED16

Access Read only

PDO Mapping No
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Name Id Bits 0...31
Subindex 02h
Data Type UNSIGNED16
Access Read only
PDO Mapping No
Name Id Bits 32...63
Subindex 03h
Data Type UNSIGNED16
Access Read only
PDO Mapping No
Name Id Bits 64...95
Subindex 04h
Data Type UNSIGNED16
Access Read only
PDO Mapping No
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7.4 Objects for Internal Use Only

The objects listed below are not intended for use by the end user. Some of them are used for configuration
purposes.

Explanation/Designation

0x10F1h Error Settings

0x1CO00h Sync Manager Type
0x1C32h SM Output Parameter
0x1C33h SM Input Parameter

0x2000h Ref Voltage for uC1

0x2002h Supply 5 Voltage to uC1
0x2003h Supply 3.3 Voltage to uC1
0x200Bh Number of CORA Test Cycles of uC1
0x2020h MaxAsicDataUnequalCounter
0x2212h Post Result Flag

0x2220h MC1 Main Loop Cycle Time
0x5001h Id MC1

0x5003h Id MC3

Ox5E5Eh Creates the 'device stamp'
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7.5 Standards Complied With

7.5.1 Product Standard Applied

->  EMC Directive 2014/30/EU
>  EN61131-2:2007
Programmable logic controllers — Part 2: Equipment requirements and tests

7.5.2 Safety Standards and Directives

> IEC 61508:2010 Parts 1-7

Functional safety of electrical/electronic/programmable electronic safety-related systems
> EN ISO 13849-1:2015

Safety of machinery — Safety-related parts of control systems - Part 1. General principles for design
> EN 62061:2005 + AC:2010 + A1:2013 + A2:2015

Safety of machinery - Functional safety of electrical, electronic and programmable electronic safety-related
control systems

> EN 60204-1:2006 + A1:2009 + AC:2010 (excerpts)
Safety of machinery — Safety-related parts of control systems - Part 1. General principles for design

7.5.3 EMC Standards

EMC immunity to noise:
> Generic standard DIN EN 61000-6-2:2005

Electromagnetic Compatibility (EMC) - Part 6-2: Generic standards - Immunity for industrial environments
-> Product standard DIN EN 61131-2:2007

Programmable logic controllers — Part 2: Equipment requirements and tests

Elevated immunity levels of safety-related applications
> DIN EN 61131-6:201
Programmable logic controllers — Part 6: Functional safety

EMC noise emission
> Generic standard EN 61000-6-4:2007 + A1:2011

Electromagnetic Compatibility (EMC) - Part 6-4: Generic standards — Emission standard for industrial envi-
ronments

> Product standard EN 61131-2:2007
Programmable logic controllers — Part 2: Equipment requirements and tests
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7.6 Directives and declarations

7.6.1 Declaration of conformity
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|t - AW 453 f1G -0
Telmnr A0 547 402754
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The original EC Declarations of Conformity and the related documentation are kept at the disposal of the compe-
tent authorities. Please contact the product management department if necessary.
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7.6.2 TUV certificate

EC Type-Examination Certlflcate

E E N\ Product Sefety
Functions!
Safsty
Wi luy gom
12 2824CeC00
Reg.-Nr./No.: 01/205/5599.00/17
Priifgegenstand Sichere speicherprogrammierbare Zertifikats- Kerdrion Kuhnke Automasion
Product tested Steverung (SPS) mit FSoE Schnittstelle  inhaber GmbH
Safety programmable logic controlier Certificate Litjenburger Str. 101
(PLC) with FSoE Interface holder 23714 Malents
Germary
Typbezeichnung Kutnke FIO Safety PLC - 634 330 00
Type designation
Prilfgrundiagen EN ISO 13848-1:2015 EN 61131-22007
Codes and standards IEC 82061:2015 + AC2015 EN 60204-12006 + A1:2000 + AC:2010 (in
|IEC 61508 Parts 1-7:2010 exdracts)
IEC 61326-3-12008 + AC:2008
BestimmungsgemiBe Die sichere speicherprogrammierbare Steuerung erdiilt die Anforderungen der
Verwendung (Kat. 4/ PL e nach EN ISO 13848-1, SIL CL 3 nach IEC 62061 / IEC 61508) und kann in
Intended application Arwendungen bis zu diesen Sicherheitsleveln singesatzt werden.

The salety programmable logic controlier compilies with the requirements of the relevant
standards (Cat. 4/ PL e acc. 10 EN ISO 13848-1, SIL CL 3 acc. 10 [EC 62081/ IEC 61508)
and can be used in applications up 10 hese safely levels.

Besondere Bedingungen Die Hinweise in der zugehirigen Installations- und Betriebsanieitung sowie des
Specific requirements Sicherheitshandbuchs sind 2u beachten.
The instructions of the associated Installation, Operating and Safety Manual shall be
considered.
Es wird bestitigl, dass der Priligegenstand mit den Anfarderungen nach Anhang | der Richiinie 2006/42/EG Ober Maschinen

Obereinstimmt.
It is confirmed, that the product tested complies with the requirements for machines defined in Annex | of the EC Directive
200642EC.

Gilitig bis / Valid until 2022-07-04

Der Ausstellung dieses Zertifiates llegt eine Priifung zugrunde, deren Ergebnisse im Bericht Nr. 968/FSP 1413.0017
vom 04.07.2017 dokumentiest sind.

Dieses Zertifikat st nur gitig fir Erzeugnisse, die mit dem Prilfgegenstand Obereinstimmen. Es wird ungditig bel
Jegicher Anderung der Prilfgrundiagen fiir den angegebenen Verwendungszweck.

The Issue of this certificate is based upon an examination, whose results are documented in

Report No. 968/FSP 1413.00/17 dated 2017-07-04, /':"“

This certificate s valid only for products which 30 ‘mmmw It becomes invalld at any change of
the codes and standards forming the basis of

Toh: +4 30 TH 2607, Fax +49 30 7062970, EMak ndustriese vica@de Lvoom

WAZ 2 LEAM © YO/, TUEYand TUY we regiitered traderrarian Ul sstion & i s ol CRtion be qul e (o f o ppeovd
TOV Mmniand hoatre Senvice Gt Aboimtr. 54, 12103 Bertn / Gerrrany

=
Berlin, 2017-07-04 E
Notified Body for Machinery, NB 0035 Dipl.-Ing. Eberhard Frejno
www._fs-products.com " . e
WAL VLG A TUVRheinland™~
Precisely Right.
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Sales & Service

8 Sales & Service

Please visit our Internet site to find a comprehensive overview of our sales and service network including all
the relevant addresses. Feel free to also contact us at our headquarters in Malente/Germany:

gKENDRlON

WE MACNETISE THE WORLD

‘ . ‘ Produkte ’ Branchen | Kundenspezifische Losungen

M W 3\ ..
ut omat
\ ‘7}‘}‘},‘&"}““\\‘

tem:

\\1\\

Kuhnke
Steuerungstechnik

Fluidtechnik

Kuhnke Pneumatik und Q /'g i
["Erfahiren Sie menr v | .

8.1.1 Malente Headquarters

Kendrion Kuhnke Automation GmbH
Industrial Control Systems
Latjenburger Stral3e 101

D-23714 Malente, Germany

Tel. +49 4523 402-0
Fax +49 4523 402-201

Emailsales-ics@kendrion.com
Web www.kuhnke.kendrion.com
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